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About the Documents Module

An immense amount of data is generated throughout the life of a project, and the Documents module gives
team members a central location to store, organize, and access the files they need. Folder permissions can be
set to limit access to specific files. In this way, administrators control who is able to submit, edit, delete, and
view the files in each folder. The folder structure can be arranged in any way that is best suited to support your
internal processes. It gives all project participants, from the Project Executive to the Project Assistant, quick
access to project files.

One of the key advantages of using the Trimble Unity Construct Documents module is that all project members
are able to access the most up-to-date files from any location, at any time. The Documents module makes it
easy to share documents via email or through notifications. In support of the collaborative nature of capital pro-
gram management, team members are able to work on files collectively, check files in and out of the system,
and redline documents while maintaining document version control. When internal or external participants are
uploading files into the system, they are required to specify a folder in the document structure, which ensures
that all files within the system are stored in a central location.

For increased visibility, features such as document access history are available to Administrators. You can
also restore deleted files, and users with the appropriate permissions can easily review and modify document
custom fields. Whether in the planning, design, build, or operating phases of the project, the Documents mod-
ule streamlines the exchange and sharing of information while reducing the effort, time and cost associated
with this process.

Access Project Documents Page

There are two methods of accessing the Project Documents page. The first method is from the top navigation
tabs, which should be used if you are not already in a project. However, if you are in another module within the
same project, the best method of access is from the Project Menu, which will help you avoid having to reselect
your project.

To access the Project Documents page for a specific project

1. Click the Documents tab located on the top navigation tabs.
2. Choose a project from the All Projects menu.

The Project Documents page is displayed.

To access the Project Documents page for the current project

If you are already within a project, you can access the Documents module via the Project Menu located in the
Left Navigation Pane.

¢ Click Documents.

The Project Documents page is displayed.

Documents Page Overview

The Documents page is central to working with documents. The folder structure is located in the left pane.
When you select a folder, it display its contents in the adjacent content pane.
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Documents For | KziTraining Center - ABC Construction -

Toggle Between Detailed and
Expanded Folder View

Folders. LB

[ Folder |
1 Controls

Documents

@
I Documents [11]
[ Bid Responses [0]

[ Bidding [4] Fl\apse/&pand
[ construction [11 ! chf=e
—

[ Pplan Room [3]
[ procurment [0]
[ Pprogress Photos [0]
[ submittals [1]

Name Date Uploaded

Delete | Move | Copy | Download | Check Out | Send | Fill outForml —{ Document |
| Controls
b 1213 03:02PM

-_lﬂ e-Builder Individually Licensed User Guide.pdf (version3)

}! Download (620.2KE) | Redline | Send | Properties
Schedule of Values.xls (version 1]
f [ 1

Download (17.4KB) | Redline | Send | Properties i I

1- 2 of 2 documents

7/—) [T show File Descriptions -] Show Thumbnails

=

B
Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard: Private URL - Public URL |

select All

Uploaded By Company
Page 1E of 1 Show |25 E per page

Benouchka Sylverne eb

Benouchka Sylverne eb

Documents controls

The controls located directly above the list of documents allow you to take action for one or more of the

selected files.

Documents \ Bidding \ Bid Responses \ Earth Science Wing

[ Sho\

Upload | Properties | Create Folder | Subscriptions | Copy To Clipbeard: Private URL - Public URL
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Delete | Move | Copy | Download | Check Qut | Send | Fill Out Ferm | Compare
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- Download (668.1KB) | Redline | Compare With | Send | Properties | Edit
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11.02.11 10:09AM

1 - 2 of 2 documents

¢ Delete: Deletes the selected files.

e Move: Moves the selected files to a different folder or project. For instructions, see Move Docu-

ments.

e Copy: Copies the selected files to a different folder. For instructions, see Copy Document.

¢ Download: Downloads the selected documents. If more than one file is selected, it zips the files for
download.

Check Out: Checks out the selected files. For instructions, see Check Out Files.
Send: Sends the file via email or notifies an internal user of the document. For instructions, see
Send Files.

Fill Out Form: Fills out a form with the selected files attached. For more information, see the Fill Out
Form window.

Compare: Compares two selected files. The document compare feature allows you to identify the
changes that have been made to afile. You can view files in different ways to best suit your needs.
Overlays with difference detectors, side-by-side views, and highlighting the additions and deletions
are all options that are available to you. For instructions, see Compare Documents.

Individual document actions
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Documents \ Construction [ Show File [
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Delete | Move | Copy | Download | Check Qut | Send | Fill Out Form | Compare Page
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Download (17.4KB) | Redline | Compare With | Send | Properties | Edit

Presidential Towers - First Floor - Ceramic Tile.xlsx (version 1)

Download (8.3KB) | Redline | Compare With | Send | Properties | Edit kil

e-Builder Insurance Policy.docx (version 1) "/
Download (70.6KEB) | Redline | Compare With | Send | Properties | Edit

08.08.13 05:55PM

Individual Document Controls

1 - 3 of 3 documents

Filename: Click on the filename to view it in a document viewer.
Document Viewer - Supported File Types
The following file types can be viewed in the document viewer:
° doc
° docm
° docx
° eps
° msg
° mpp
° nwd
° ppt
° pptx
o rtf
° txt
° vsd
° xls > 15 MB (Convert large files to .xlIsx)
° xlsb
° xlsm

° xlsx

Note:

° To view file types that cannot be viewed in the document viewer, you must first download it
and view it with its native application.

°  Afilename that is greyed out indicates that it is being processed to be viewed in the doc-
ument viewer. Large files may take some time to process.
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° A greyed out filename may also indicate that the file is not able to be processed for viewing
due to unsupported file type or overly large file size.

° Files that cannot be viewed (greyed filename) are problematic when attached to a process
instance as part of a mail merge. The mail merge will not execute with this attachment and
the process will stall.

° PDF documents created using Adobe LiveCycle Enterprise Suite are not supported in mod-
ern browsers (e.g., Chrome 45 and later, Firefox 52 and later, Edge.) To view them, down-
load and view them using Adobe PDF Reader, or convert the files to a format readable by
browsers. To convert the file, open itin Adobe PDF reader, then print the document and
choose Microsoft to PDF as the printer. This will create a PDF that can be uploaded and
viewable in e-Builder.

Download: Downloads the file, which allows you to save or make changes in its native application.
Redline: Annotates or marks up the file. Redlining does not modify the actual file. It creates an over-
lay on top of it that exists only in e-Builder. After you save your redline and return to the Documents
module, a counter appears under the file name that shows how many redline layers have been cre-
ated for the document.
Tip

To view a redline markup outside of e-Builder, save the markup as a.jpg (image).
Compare With: Compares the file with another document saved in the document library. The doc-
ument compare feature allows you to identify the changes that have been made to a file. You can
view files in different ways to best suit your needs. Overlays with difference detectors, side-by-side
views, and highlighting the additions and deletions are all options that are available to you. For
instructions, see Compare Documents.

Send: Sends the file via email, or via fax to an internal or external project participant. For instruc-
tions, see Send Documents.

Properties: Displays individual file properties. For a description of this window, see File Properties
General Tab Overview.

Edit: This link is only available for Word, Excel and PowerPoint files. Click to edit any of these files
types within their native application. The ability to edit documents directly from e-Builder will help
you avoid having to download the file, make changes, save to your local directory, and then upload
the file back into e-Builder. When you edit documents in place, all of your changes are saved in a
temporary file that allows you to navigate away from the file and e-Builder, and return to complete
your changes at your leisure. To save the updated document in e-Builder, click the Check In link,
and the file will be saved as a different version.

Delete | Move | Copy | Download | Check Out | Send | Fill Qut Ferm | Cumpare/

@' B ImportBidScopeltems.xls (version 1) Checked out by Benouchka Sylver
Download (26.1KB) | Redline | Compare With | Send | Properties | Edit | Check In

A-E Std Long-Form (v042408) REV Anne (4).doc (version 3) Chedxkd
w [[] out by Benouchka Sylverne 0
Download (180.2KB) | Redline | Compare With | Send | Properties | Edit
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Note: Account administrators are able to check files in at any time. In the event that the person
who originally checked the file out for editing is not available, account administrators will be able to
undo checkout in the file's properties or by clicking Check In from the Project Documents page.
The file will be saved as a new version and all changes made by the editor will be maintained.

For more information, see Edit Documents.

e Check In: This link is only visible to those who currently have the file checked out, and to account
administrators. These users have the option to check files in if the file was checked out or is currently
being edited.

Access Document History Page

The Access Document History page allows you to locate documents stored in the Documents module. Use
this page to view the access history of specific files. From this page you're able to search for files that are cur-
rently in the system or have been deleted.

Forinstructions, see View Document Access History.

The fields and buttons located on this page are:

Fields and Buttons

» Access Document History for: Click to view document access history for a different project.

Filter Documents - Fields and Buttons

Document Name: Enter the name of the file.
Document Type: Enter the document's file extension.

Accessed By: Enter a username to filter results by. Only one username can be entered at a
time.

Company: Enter a company name to filter results by. Only one company name can be entered at
atime.

Access Type: Click to select an access type to filter by.

Date Range: Enter a date range to filter by. You can also click the calendar icons to select dates
from the calendar.

Filter: Click to filter by the selected criteria.

Results Table - Fields and Buttons

Version: Display the document version number.

Document Name: Displays the name of the file version.

Accessed By: Displays the name of the user that accessed the file version.

Accessed By Company: Displays the name of the company that the Accessed By belongs to.
Access Type: Displays the method that the file version was accessed.

Timestamp: Displays the date and time the file version was accessed.

Export to Excel® Icon: Click to export the record to an Excel spreadsheet.
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Sent Items Page

The Sent Items page allows you to search for files that have been emailed or sent via notification, from the
Documents module. For steps on sending items from the Documents module, see Send Documents.

A description of the fields and buttons located on this page follows:

e Cancel: Click to cancel the search and return to the Project Documents page.

¢ Project: Displays the name of the project you are in.

¢ Project Number: Displays the project number, if available. Administrators have the ability to set project
numbers by going to Setup > Projects > Project Settings. This is a string-type project custom field. For
instructions on creating this field, see Manage Custom Fields.

¢ Show Failed Messages: Select this check box to include only failed messages in the filter results.

Filter
e Sent To:To search for a single user at a time, enter the name of participant that messages were
sent to.
» Subject: Enter the subject of the messages you want to filter by.
* File Name: Enter the file name you want to include in the filter.
» Date Sent Between: Enter a date range that the file was sent to include in the filter.
e Body: Enter a single keyword or phrase contained in the body of the message to filter by. Avoid the
use of commas.
e Type: Select the delivery type of the sent item.
« Filter: Click to filter by the selected criteria.
* Reset: Click to clear filter fields.
Messages

Subject: Displays the subject of the message. Click to open message details in a separate window.
Date Sent: Displays the date and time the item was sent.

To: Displays the Name, Email Address that the item was sent to.

Sent By: Displays the name of the user that sent the message.

Delivery Address: If sent to a Trimble Unity Construct contact or user, their delivery address dis-
plays here.

Status: Displays the status of the items.

# Times Opened*: Displays the number of times the file was opened. This number may be unre-
ported if the if recipient email client blocks images.

Document Log Page

The Document Log page displays a list of all project documents stored in the Documents module. You can use
this page to learn about when a file was uploaded and by whom, the folder path where it is stored, its checked
in or check out status, and where it is used throughout the system.

The following fields and buttons are available on this page:
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e # Files | # Versions | # Storage Used: The # Files indicates the number of individual files that have
been uploaded. If you upload new versions of a file, the # Versions count will include the versions.
Example: File A and B were uploaded yesterday. A new version of a file is uploaded today = 2 Files , 3
Versions

¢ Show Empty Folders: Select to show empty folders in the list below.
¢ Show Checked-Out Files Only: Select to filter for files that have been checked out.

e Export: Click to create one of these exports: Excel Data Export, CSV Data Export, or Tab Delimited
Text.

¢ Folder Name: Displays the folder path where the file is stored.

¢ File Name: Displays the file name.

¢ File Size: Displays the file size.

¢ Uploaded By: Displays the name of the user that uploaded the file.

¢ Date Uploaded: Displays the date that files were uploaded.

¢ Redline Count: Displays the number of redlines saved on the file. Click to open the document.

¢ Checked Out By: If currently checked out, displays the name of the person that has the filed checked
out.

¢ Date Checked Out: If currently checked out, displays the name of the person that has the filed
checked out.

¢ Attached To: If the file is attached to a process, cost item or meeting item, the Attached To link dis-
plays. Click to view all items the file is attached to and associated details. The File Properties - Attached
To window displays.

Find Deleted Items Page

This page will only display for users with administrative permissions.
The Find Deleted ltems page allows you to search for, view, and recover deleted items.

Fields and Buttons
The fields and buttons located on this page are:

» Search for: Enter the name of the file, including the file extension that you want to search for.

Tip: Use an asterisk (*) as a wildcard search.

e Searchin:
° File names: Select to include document file name in search results.

° Folder names: Select to include folder name in search results. Click the adjacent drop-down
arrow to select a date range when items were deleted.

» Search: Click to search for deleted items. Results display in the table below.
¢ Name: Displays the name of the deleted file.

« Date Deleted: Displays the date that the item was deleted.

e Deleted By: Displays the name of the user that deleted the item.
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» Folder Path: The folder path where the file was located displays underneath the file name. Click this
link to open the Folder Properties - Recycle Bin page where account and project administrators can
optionally restore the file.

Documents Custom Fields Page

Folder and document custom fields can be modified by system and project administrators only.

This menu option does not display if Project Document Control has not been enabled on the Project Details
Settings tab. The administrator must also establish document type and custom field associations.

The Documents Custom Fields page is optimized for viewing document types and custom fields, which makes
it easier to view or modify multiple folder and document custom fields at a time.

Fields and Buttons
The fields and buttons located on this page are:
¢ Document Custom Fields for: Click to view document custom fields for a different project.

* Show untagged files only: Select to display only those files and folders that do not have document
custom fields filled out. See Update Document Custom Fields and Update Folder Custom Fields for
more information.

¢ File: Displays selected file name. Click the left and right directional arrows to select the previous or next
file in the selected folder.

¢ Save: Click to save changes.
¢ File Description: Enter a description of the file.

¢ Document Type: Click to specify a document type to be the default value for all uploaded files in this
folder. If document types and custom field associations have been established, the associated custom
fields appear in the Custom Field section below for you to choose from. For instructions on making
these associations, see Associate Custom Fields with Document Types.

If the e-Builder Plan Room is enabled on your account, the document type classification is necessary
for users to locate and view files in the plan room viewer.

Note: If a document type is set on the parent folder, it will display here automatically, because sub-
folders inherit the document type selection of the parent folder.

¢ Custom Fields: This section automatically displays if a document type is selected that has custom
fields associated to it. Enter a value for each custom field.

File Properties General Tab

This window is displayed when the document properties link is selected on the Project Documents page. The
General tab is highlighted by default. From here you can view file property details and take the following
actions:

¢ Redline Documents

¢ Move Documents

¢ Copy Documents
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¢ Check Out Documents

¢ Check in Documents

¢ Revertto a previous version of the file

To revert to a previous

Fields and Buttons

View: Click to view the file in a separate window.

Redline: Click to add redline markups to the file.

Download: Click to open the file or save it locally in its native format.
Delete: Click to delete the file. You are prompted for confirmation.

Check In: Click to check in the file. Only displays for files that are currently checked out. If a different
file name is checked in, the new file name will be used, but the version number will be updated. Files
can also be checked in by uploading the file (with the same name) into the same folder. For detailed

steps on both methods, see Check In Files.

Undo Check Out: Click to check in a file that was recently checked out.
Check Out: Click to check out the file.

Revert to Revision: Click this button to revert a file to a particular version. This button is displayed
and available only when there are multiple versions of a document.

Move: Click to move the file to a different folder or project. Moving files automatically deletes files in
the original location. When a file is moved between projects all of the history associated with the file
is deleted. Using this feature, users do not have to manually delete old files after they have been
copied over. If you do not want to delete the original documents, do not move the files, you may
choose to copy documents instead.

Copy: Click to copy the file to another folder or project.
Save: Click to save changes.
Cancel: Click to discard changes and close this page. All unsaved changes will be lost.

Name: Displays the name of the file. This is also an editable field. The version of the file displays in
parentheses next to this field.

Description: Displays a description of the file, if one exists. This is also an editable field.
Type: Displays the file type.

Location: Displays the folder path where the file is saved.

Size: Displays the file size.

Added By: Displays the user that uploaded the file to this folder.

Date Added: Displays the date that the file was added.

Last Modified By: Displays the user that last modified the file.

Date Modified: Displays the date the file was modified.

Private File URL: Displays the file's private web address, which can be sent to other Trimble Unity
Construct users. Recipients will have to log into Trimble Unity Construct to access the file if they are
not already logged in.
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e Public File URL: Displays if the folder the file is saved in is a public folder. This is the files URL,
which can be sent to external project participants.

» Check Out By: Displays the name of the person that currently has the file checked out.

File Properties Custom Fields Tab

This tab allows you to view and modify the file's document type and custom fields. This tab does not display if
the Project Document Control has not been enabled on the Project Details Settings tab.

Tip
If you'd like to modify the custom fields for a number of files at a time, go to the Document Custom Fields
page, where you can scroll through all the files in a given folder and specify the custom fields for each. For
instructions, see Review Folder and Document Custom Fields.

Fields and Buttons
The fields and buttons located on this page are:
» Save: Click to save changes.
¢ Cancel: Click to discard changes and close this page. All unsaved changes will be lost.
¢ Name: Displays the file name.
¢ Document Type: Displays the file type. Click the drop-down arrow to assign a different file type.

e Custom Fields: This section lists all document custom fields that have been associated with the selec-
ted document type. For more information, see Associate Custom Fields with Document Types.

File Properties History Tab

The history log of a document allows account and project administrators to see who accessed the file, when
the file was accessed, and in what manner.

Fields and Buttons
The fields and buttons located on this page are:
¢ View History for All Versions: Select to view the history for all document versions. The history for the
most recent version displays by default.
¢ Cancel: Click to close this window.

¢ Version: Displays the version of the file. File versions can be created by uploading the same file (with
the same name) into the version and by checking files out and then checking them in again. See Check
Out Files and Check In Files for more information.

¢ Name: Displays the name of the person who accessed the file.
e Company: Displays the company associated with the person that accessed the file.
e Timestamp: Displays the date and time that the file was accessed.

¢ Access: Displays the manner in which the file was accessed.
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File Properties Permissions Tab

This tab allows you to view and modify file permission settings. When a document is uploaded, it inherits the
parent folder's permission settings, but you can change settings for individual files as well. Document per-
missions are role specific, and cannot be set for individual users. Add the roles you wish to specify permissions
for, and then create your settings for each selection.

From this tab, you can Redline documents.

Fields and Buttons
The fields and buttons located on this page are:
e OKI/ Apply: Click to save changes.
¢ Cancel: Click to cancel and close this window. All unsaved changes will be lost.

¢ Add: Click to open the Add Permissions window and select the roles or users you want to set access
rights for. For your convenience, you have the choice of specifying permissions on the Add Per-
missions window or on this page; the same permission check boxes are available on both.

* Remove: Click to remove the selected role from the list of roles below. If a role is not listed, it means
that role does not have access to this file.

¢ List Members: Click to open the Members window and view who the members of the selected project
role are.

¢ View: Select to allow users in the highlighted role permission to view this file in this project. (Any author
or recipient of the file will be able to see the files they created/ received, regardless of this permission.)

¢ Download: Select to allow users in the highlighted role to download the file to a local storage in the nat-
ive file that the file was uploaded in.

¢ Redline Markup: Select to allow users in the highlighted role to redline or mark up a file.

¢ Modify: Select to allow users in the highlighted role to update the document name and description. This
allows you to have version control to this file. If not selected, a new file will be created upon upload with
a sequential number versus another version.

¢ Delete: Select to allow users in the highlighted role to delete this file, even if another user created it.
¢ Change Permissions: Select to allow users in the highlighted role to Update permissions for this file.

¢ No Access: This role has no access to this file. This permission overrides any other permissions the
user may be granted. Once you have selected your permissions, click Apply.

File Properties Versions Tab

This tab allows you to view the different version of the file. File versions can be created from checking out and
checking in files as well as by uploading new versions of the same file, as long as the file name is the same.
From this tab you are also able to view and download files.

Fields and buttons

The fields and buttons located on this page are:
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e Cancel: Click to close this window.

e Compare: Select the check box of the two versions you wish to compare and then click Compare.
This button appears only when there is more than one version.

» View: Click to view the file in a separate window.

e Download: Click to download the file.

« #: Displays the file's version number. Click to view the general properties of this file.
» File Name: Displays the file name. Click to view the general properties of this file.

« Description: Displays the file description.

e User: Displays the user that uploaded the file.

» Date Created: Displays the date the file was created.

File Properties Attached To Tab

This page provides a list of all the items the document is attached to. A document can be attached to any of the
items listed below:

¢ Budget, Commitments, Invoices

e Bid Packages

e Forms

¢ Process Instances

¢ Planning Scenarios

Fields and Buttons

The fields and buttons located on this page are:

Forms
* Project: Displays the name of the project that the file was attached in.
e Form: Displays the form type that the file was attached to.
* Subject: Displays the subject of the form.
» Author: Displays the name of the user that attached the file.
e Held By: Displays the name of the user whose court the form is currently in.
e Date Due: Displays the form's due date.

» Attach Type: Displays the manner in which the file was attached.

Process Instances
* Project: Displays the name of the project that the file was attached in.
e Process: Displays the form type that the file was attached to.
» Subject: Displays the subject of the process.

e Date Due: Displays the date that the process step is due.

Step Name: Displays the step that the process is currently in.

In Step Since: Displays how long the process has been in the current step.
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Working with Documents

From the Documents module, you can do perform the following actions on documents:

Upload Documents

To upload documents

1. Go to the Project Documents page.

2. Select the folder that you want to upload files to.

3. Click the Upload link.

4. Drag and drop your files to the File Upload window.
—Or—

Click Browse and locate the files to upload.

Tip: You can also drag and drop (or browse) your files to the Documents content pane.

Open Documents
From the Project Documents page, you will only see the folders and files you have access to. By default, the
contents of the folder appear in the Content Pane.
To open documents
1. Go to the Project Documents page.
2. Select the folder that holds the file you want to open.
3. Click the title of the document.

Download Documents

Downloading documents gives you the option to open the file forimmediate viewing or save the file locally.
This option might be confused with checking-out files, which should only be done if you want to restrict access
to a certain document while you make changes to it. For more information, see Check Out Documents.

To download documents
Go to the Project Documents page.
Navigate to the file you want to download.

Click the Download link located under the file name you want to download.

S

Click Open to open the file.
—Or—

Click Save to save the file locally.

Delete Documents

Deleting documents removes the files from the Documents module. However, if the file was attached to in
other modules in e-Builder, such as Forms or Processes, the attached files will not be deleted. Only users with
delete permissions for the folder where the file is stored is able to perform this function. Once files are deleted,
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they can only be recovered by an account or project administrator.

To delete documents
1. Go to the Project Documents page.
2. Navigate to the file you want to delete.
3. Select the check box next to the file you want to delete.
—Or—

To delete all the files in the folder, click the Select All check box.

Documents

Upload | Properties | Create Folder | Subscriptions
mEA

Delete | Mowve | Copy | Download | Check Ou

e-Builder Individually Licensed User
1' Download (620.2KE) | Redline | 5end |

Schedule of Valuesads [version 1)

P
= Download (17 4KE) | Redline | Send | Pr

4. Click the Delete link. You are prompted for confirmation.
5. Click OK.

Move Documents

Trimble Unity Construct

You have the ability to move files between folders and across projects. Moving files automatically deletes them
from the original location. When a file is moved between projects, all of the history associated with the file is
deleted. When using this feature, you do not have to manually delete old files after they have been copied
over. If you do not want to delete the original document, you might choose to copy documents instead.

Note: You need to have Create Folder permissions and Modify Document permissions to perform this task.
For instructions, see Edit Folder Permissions and View/Edit (Manage) Document Permissions.

To move documents between folders or projects
1. Go to the Project Documents page.
2. Navigate to the file you want to move.
3. Select the check box next to the file you want to move.
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Documents / Submittals
Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard: Private URL
] | Name

Delete Copy | Download | Check Qut | Send | Fill Qut Form

@ E Submittal Training Guide.doox jversion 1)
- Download | Redline | 5end | Properties

Submittal - Product EnhancementSolution Definition.docx (version 1
Download | Redline | Send | Properties

Uil

Click the Move link located above the file list.
The Move File window is displayed.
Note: If you do not want the file to inherit the permissions of the folder you are moving the file to, clear

the Inherit file permissions from destination folder check box as this setting is enabled by
default.

To move files to a different folder within the same project, click the folder name. When prompted, click
OK.

—Or—

To move files to a different project, select the project from the Move [number of files] to Project drop-
down menu. Navigate to and select the destination folder. Click OK on the confirmation dialog box.

Copy Documents

Documents can be copied to different folders and across projects by anyone with access to the file.

Note: You need to have Create folder permission on the folder you are copying the file to in order to perform
this task. For instructions, see Edit Folder Permissions.

To copy documents

1.

o > 0N

Go to the Project Documents page.
Navigate to the file you want to copy.
Select the check box next to the file.
Click Copy.

To copy files to a different folder within the same project, click the folder name. You are prompted for
confirmation. Click OK.

—Or—

To copy files to a project, click the projects drop-down arrow and select a project. Navigate to and
select the destination folder. When prompted, click OK.
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Check Out Documents

The Check Out feature in e-Builder allows you to hold exclusive rights to upload new versions of a document.
When a document is checked out, all other users are blocked from uploading a new version of the file. The
benefit of using this feature is that all users are informed that you are making updates to the file, and it prevents
them from uploading their changes while you have the file checked out.

To check out documents

o > N =

Go to the Project Documents page.

Navigate to the files you want to check out.

Select the check box next to the files.

Click the Check Out link located above the file list.

To download the file at this time, click OK.

—Or—

To confirm the check out, but not download the file, click Cancel.

Revert Document to a Previous Version

When there are multiple versions of a document, e-Builder allows you to revert a file to a particular version.

To revert a document to a previous version

6.

Go to the Project Documents page.

Click the Properties link for the document you wish to revert. The File Properties window is displayed
and the General tab is displayed by default.

Go to the File Properties - Versions tab.

Click the file name of the previous version of the file that you wish to revert to.
The File Properties - General tab of that version is displayed.

Click the Revert to Revision button.
You will be prompted to confirm whether you wish to revert the document to this version of the file.

Click OK to confirm. The selected version will be added as a new version number (incremental).

Undo Check Out

In that event that files were checked out by accident, the person that checked the file out has the ability to
reverse this action and undo check out.

To undo check out

o > N =

Go to the Project Documents page.

Navigate to the folder where the file was checked out of.
Click the file’s Properties link.

On the File Properties window, click Undo Check Out.
Click Save.
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Check in Documents

Only the user who checked out the document and administrators have the ability to check in files. In the event
that documents were checked out by accident, you can undo check out. There are two other ways to check in a
file: by uploading the file (with the same name) into the folder it was checked out of, or by clicking the Check In
button in the File Properties window. You will not be able to check in a document if its name has changed
because it will be considered a new file.

Undo Check Out
To undo check out
Go to the Project Documents page.
Navigate to the folder where the file was checked out of.
Click the file's Properties link.
Click Undo Check Out.
Click Save.

o N~

Check In by Uploading into Folder

To ensure a successful check in, please make sure that you are checking in the exact same file name. The
version number will automatically update after the file has been uploaded.

To check in a file by uploading it

1. Go to the Project Documents page.
2. Navigate to the folder where the file was checked out of.
3. Click Upload.
4. Click Select Files to navigate to and select the file you want to check in.
5. Click Upload Now.
6. Click OK.
If document custom fields are enabled on your account, the Update Custom Fields window is dis-
played.
Update document custom fields.
8. Click Save.
9. Click Close.

Check In via File Properties Page

Note: If a different file name is checked in, the new file name will be used, and the version number will be
updated.

To check in afile via file properties

1. Go to the Project Documents page.
2. Navigate to the folder where the file was checked out of.
3. Click thefile's Properties link.
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Click Check In.

On the Upload File page, click Browse.
Navigate to and select the file.

On the Upload File page, click Upload File.

© N o a A

On the File Properties tab, click Save.

Compare Documents

Compare documents to each other in order to identify the changes that have been made to the file. You can
view files in different ways to best suit your needs;\: overlays with difference detectors, side-by-side views, and
highlighting the additions and deletions are all options that are available to you.

Note: To compare documents, you must have Redline Markup permission for the folder in which those doc-
uments are located.
To compare documents

Go to the Project Documents page.

2. Navigate to one of the documents you want to compare and click Compare With.

Daily Reports.pdf (version1)
Download [2.3MEB] | Redline | Compare With | S5end | Properties

3. On the Compare Documents from window, select the check box next to the other document to use in
the comparison.

4. Click Compare.

The files open in the Compare Tool.
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Send Documents

The send feature allows you to send files directly from the Documents module to individuals who are not
licensed Trimble Unity Construct users or to license holders who do not have access to specific folders on the
project. Files can be sent via email. You can also notify internal users of files by choosing the notify option.
This sends users the name of the files and a link to where the files can be retrieved in Trimble Unity Construct.
You can send / notify a single file or a group of files located in the same folder.

To send files or notify users
1. Go to the Project Documents page.
2. Navigate to and select the check box next to the files you want to send.
3. Click the Send link located above the file list.
4. Select a method for sending:
° Email: Email files to internal or external project participants
° Notify: Notify internal project participants
Click Next.
Complete all necessary fields.
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Tip
When sending an email, use your keyboard to auto-fill and select the desired email addresses.
Begin typing the recipient's name or email address, then use the arrows to highlight the email of
choice, and then click Tab to make the selection.

7. Click Send.

Browser Settings for Editing Documents in Place

When editing files for the first time using Google Chrome ™ or Mozilla® Firefox®, you will be prompted to com-
plete browser settings as described below.

¢ Google Chrome™ Browser Settings

¢ Mozilla® Firefox® Browser Settings

Preliminary Settings for Google Chrome™ Browser

In the Google Chrome browser, a message from Microsoft Office appears in the banner of every page that
includes an Edit link. Click Always run on this site to enable document editing from e-Builder Enterprise.
This is a one-time setting that will not have to be reconfigured.

*— Microsoft Office needs your permission to run. lRun this time l IAIways run on this site ‘ Learn more %

Preliminary Settings for Mozilla® Firefox® Browser

When using the Mozilla Firefox browser, you will be prompted to allow e-Builder to run Microsoft® Office®.
This message will appear in the banner of every page that includes an Edit link. Click Allow to enable doc-
ument editing from e-Builder Enterprise.

8 Allow e-builder.net to run "Microsoft Office"? ’Continueﬂlocking ] [ Allow... w b 4 ‘

A subsequent message displays, requesting you to choose a setting for future occasions. Click Allow and
Remember.

x
Allow e-butlder.net to run "Microsoft Office"?
Learn More...
Allow Mow | | Allow and Hemembert

Edit Documents

Note: This feature is only compatible with Microsoft® Office versions 2010 and above. If an earlier version of
Office is installed on your machine, the Edit link will be disabled. If your organization utilizes a different ver-
sion of Office and you wish to disable this feature on your account, please contact e-Builder Support.

All Word, Excel® and PowerPoint® files that you have the permission to modify can be edited directly from e-
Builder Enterprise. An Edit link appears next to each document of these file types to help you avoid having to
download the file, make changes, save to your local machine, and then uploading the file back in to e-Builder.
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Note: Account administrators are able to check files in at any time. In the event that the person who ori-
ginally checked the out for editing is not available, account administrators will be able to undo check out via
in the file's properties or by clicking Check In from the Project Documents page. The file will be saved as a
new version and all changes made by the editor will be maintained.

Editing Documents

To edit documents in place

1. Click the Edit link next to the file you wish to edit.

The file opens in its native application.
2. Make changes as necessary and remember to save along the way.

Note: You are able to navigate away from the document and e-Builder if necessary - your changes
will be saved, as long as you save the file in its native application.
3. When your edits are completed and you're ready to check the file back into e-Builder, click Check In
next to the file.

A message informs you that a new version of the file will be saved.

- ™
Message from webpage ﬂ

A new version of the following file was created during this check in.

B N

ImportBidScopeltems.xls

L A

4. Click OK.

If document control is enabled, you are prompted to complete document custom fields.

5. If necessary, update document custom fields, click Save, and then Close.

Copy Document URL

A document's URL can be copied and then shared with internal project participants. Recipients will have to
login to e-Builder to view the document if they are not already logged in.

To copy a document's URL

Go to the Project Documents page.
Click the file Properties link, located under the file name.
Click the Copy to Clipboard link just under the File URL field.

Share the URL on a Web page or paste it into your email or instant messaging tool to send it.

S

Update Document Custom Fields

This action can be completed by Administrators and users with Document Import permissions only.
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Note: In order to tag documents with custom fields, the administrator must enable account-level document
control and establish document custom fields per document type. The individual project must also have pro-
ject-level document control enabled.

When all of these settings are in place, users will be automatically prompted to complete the document cus-
tom fields every time they upload a file to the Documents module. Tagging documents cannot be required,
and users can bypass the custom field assignment.

To update document custom fields
1. Go to the Project Documents page.
Click the Properties link under the document file name.

Click the Custom Fields tab. The Custom Fields tab will not display if Project Document Control is not
enabled.

Update the custom fields as necessary.
5. Click Save.

Import Document Custom Fields

This task can be completed by:

*  Account Administrators
®  Participants with ‘Document Import’ Permission

Prerequisite: Set Up Document Custom Field Import File

Document custom fields can be imported for multiple projects at a time. When document control is enabled on
a project, participants are able to complete document custom fields at the time of upload. However, non-
required fields may not always be entered. Also, administrators may feel more comfortable completing these
fields to ensure consistency. Importing document custom fields is a great time-saving tool that allows you to
manage these fields more easily.

To import document custom fields

Click Documents from the Top Navigation tabs.

2. Inthe Quick Links menu located in the upper right corner of the page, click Import Document Custom
Fields.

3. Click Browse to search for and select the import file.
Click Next.
If necessary, map the e-Builder built-in fields to the corresponding fields in the import file.
To learn more, see Set Up Document Custom Field Import File.
Click Next.
7. Review the import summary. If there are exceptions, click Previous to make necessary changes.
—Or—

If there are not necessary changes, click Import.
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Set Up Document Custom Fields Import File

Document custom field imports are compatible with Microsoft Excel® .xIs and .xIsx files. A single import file
can include custom fields for multiple projects. The distinction will be made by the value of the project identifier
being used in the import file.

The image below includes the name of all fields that can be added to the header row of the spreadsheet. This
image is also of the mapping step that will be encountered during the import.

If the headers in your file match these fields exactly, they will auto-populate. If the header names are different,
you must map the corresponding columns in your spreadsheet to the e-Builder built-in fields in step 2 of the
import wizard. The Document Custom Fields section lists all available document custom fields on the account.
These field labels should also be column headers in the file.

Import Document Custom Fields - Field Mappings Step 2 of 3

Document Built-In Fields
* project Identifier:
* File Name:
Description:
Document Custom Fields
Plan Room Menu:
Trade:
Zone:
Department:
Category:

Floor:

Previous Next Cancel

Project Identifier E * Folder Path: Folder Path |z|

File Version:

E0|

File Name

E Document Type: Document Type |Z|

M EHEEE K

Previous Next Cancel

Description of Required and Optional Fields for Import File

e-Builder Field
Name/ Import
File Column
Header

Project Iden-
tifier

Description Required/Optional

Select a Project Identifier. This is a unique ID that will identify Required
which project the document custom field is associated with.
Examples include project name and project number.

To learn more about project numbers, see Create Project Num-
ber Custom Field.

File Name Include the name of the file exactly as it is saved in the Docu- Required
ments folder structure, including the file extension.
Folder Path Enter the folder path that the file the currently saved in, such as Required

Documents/Construction/Specifications.
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e-Builder Field
Name/ Import

Description Required/Optional
File Column iPH qHt P
Header
Description Enter a description for the custom field value. Blank values will Optional

not change existing entries, however, new values will overwrite

existing ones.
File Version Enter the file's version number Optional
Document Enter the document type in this field. Blank values will not Optional
Type change existing entries, however, new values will overwrite exist-

ing ones.
Document Cus- | By default, all available document custom fields display on the Optional
tom Fields Field Mappings page, as illustrated in the above image. Make

the custom field labels, column headers and enter the desired

value in the appropriate columns.

View Sent ltems

You are able to see a list of messages that have been sent from the Documents module. These items include
emails and notifications. You are able to narrow your search by filtering based on specific criteria.

To search for and view a list of sent items

1. Go to the Project Documents page.
2. Inthe Project Menu, click Sent Items.

3. Filter for messages.

Note: All sentitems display by default, and you may not have to use the filter.

About Redlining Documents

Adding redline markups allow you to annotate the file. Redlining does not modify the actual file; it creates an
overlay on top of it that exists only in Trimble Unity Construct. After you save your redline and return to the
Documents module, there's a counter under the file name that shows how many redline layers have been cre-
ated for the document.
Tip

To view a redline markup outside of Trimble Unity Construct, .

Guidelines for Redlining Documents

The Redline tool is intended for markups of small to medium sized PDF files. A general rule of thumb is to use
files under 500 pages and under 250 MB. If your file does not open quickly and is near this size, we suggest
splitting the PDF into two separate files and working from there.
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Required Permissions

In order to:

You need these per-

L. Notes for Administrators:
missions:

Redline files Redline Markup Redline permissions can be granted for an individual file or

View redlined View
files

folder.

Redline Documents

Using the built-in redlining feature, you can redline documents. You can then save the redline markups to your
local machine as a PDF file. This is the only way to save redlined files and make them available outside of e-
Builder. This also allows you to make marked up files available to team members who do not have permission
to view redlined documents.

To redline documents

1.
2.

N o o &

Go to the Project Documents page.
Navigate to the file you want to redline.
Click the Redline link located below the name of the file you wish to redline.

The file opens up in a separate redlining window.

Click the Markup icon @h located in the upper left corner of the window.

Click New Markup.

From the Annotations drop down, select the type of markup you wish to make.

Once the document has been marked up, do any of the following:
° To save the file, click the Markup icon > Save Markup. Enter a unique name and then click OK.
o To save the file as a PDF, click the More icon Bl > Publish to PDF.
o To print the file, click the More icon B > Print.

Tip: You may need to maximize the redlining window to see the More icon.

Note: Click the Help icon located on the upper right corner of the window. A new window displays the
in-app help that describes all the options available on the redline window. Depending on your
browser settings, your redline window may be ‘hidden’ behind the help window.
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Open Redlined Documents

To open a redline document
1. Go to the Project Documents page.
2. Navigate to the redline file you want to open.
3. Click the Redline link located below the file name.

The file opens in a separate window.

Click the Markup icon located in the upper left corner of the window.

4.

5. Click Open for edit.

6. From the Available markup files dialog box, select the version you wish to view.

7. Optional: Select the Show first check box and select an option from the list if you would like the viewer
to automatically pre-load the first instance of this option when the markup is loaded (forwarding the doc-
ument to that page). For example, if you only want to review signatures, and the first signature is on
page 10 of the document, selecting the Signature option will load the markup file beginning with the sig-
nature item located on page 10.

8. Click OK.

Tip
If you save each of the redline versions as separate files in e-Builder, you will be able to compare at
least two of the documents side by side. See Compare Documents for more information.

Document Folders

The Documents page is central to working with documents. The folder structure is located in the left pane.
When you select a folder, it display its contents in the adjacent content pane.

Documents For | Kai Training Center - ABC Construction bl

Toegle Between Detailed and

e [ Fm |

___
Folders Lg = || Documents [ show File Descriptions [F] show Thumbnails
_1 SE\ e Up\uad | Properties | Create Folder | Subseriptions | Copy To Clipboard: Private URL - Public URLl
% Documents [11] Name « Date Uploaded Uploaded By Company
P
» Responses [0] Delete | Move | Copy | Download | Check Qut | Send | Fill Out Fol rml JDOﬂIV'EH[ Page lEofl Show |25 E per page
=3 EicnG o) Builder Individually Licensed User Guide pdf )
[ construction [1] Left Pane 47  oBuilderIndividually Licensed User Guide pdf ersion 3) 13 03:00PM Benouchka Sylverne 78

[ Pplan Room [3]

% Procurment [0]

Download (520.2KB) | Redline | Send | Properties

| @ Schedule of Values.xls (version 1)

Download (17.4KB} | Redline | Send | Properties

03.06.13 11:30AM Benouchka Sylverne eb

[ progress Photos [0]
[ submittals [1]

1 -2 of 2 documents

To access the Project Documents page

1. Click the Documents tab located on the top navigation tabs.
2. Choose a project from the All Projects menu.

The Project Documents page is displayed.

Page xxix



Trimble Unity Construct

Folders
From each project’s Documents folder, you can switch between the detailed and expanded folder views.
e Expand All: Expands all folders and subfolders.
e Collapse All: Collapses all folders and subfolders.

» Refresh All: Refreshes the items in the content pane.

Content pane

» Folder Path: The selected folder's path is displayed a the top of the content pane. Click the name of
a folder within the folder path to open it.

Documents [ Bidding / Bid Responses

Upload | Properties | Create Folder | Sub

e Show File Description: Shows the file descriptions on the content pane.

* Show Thumbnail: When this check box is selected, file thumbnails will be displayed. To avoid neg-
ative impacts on page loading performance when file thumbnails are enabled, e-Builder has limited
the display of File Thumbnails to solely image file types with the following extensions:

° png (Portable Network Graphic)

o gif (Graphics Interchange Format)

° bmp (Windows Bitmap)

° jpeg (Joint Photographic Expert Group image)

° jpg (Joint Photographic Expert Group image)
When File Thumbnails are enabled, other file extensions will not display thumbnails. However, the
following file types will display a PDF, DOC, or XLS icon instead of a file thumbnail:

° pdf (Adobe Portable Document Format)

° doc (Microsoft Word)

© docm (Microsoft Word with macros)

© docx (Microsoft Word)

° dot (Microsoft Word template file)

° dotx (Microsoft Word template)

° xls (Microsoft Excel)

° xlIsb (Microsoft Excel)

o xlsm (Microsoft Excel Macro-enabled)
° xlsx (Microsoft Excel)

o xlt (Microsoft Excel Template)
A generic icon will be displayed for other file types.

Folder controls
e Upload: Adds a new file to the selected folder.

e Properties: Views the selected folder properties.
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Create Folder: Creates a new folder inside the current folder.

Subscriptions: Creates a folder subscription. Folder subscriptions allow you to set up email noti-
fications when a change is made to the folder and its contents. For more information, see Subscribe
Yourself to Folders. If you are an Administrator, you can also Subscribe Users to Folders.

Copy to Clipboard: Copies the folder's web address for distribution to external users. To make this
folder available for public access, you must choose a public access permission setting located in the
properties of the folder. For detailed steps, see Enable Folders for Public Access.

Private URL - Copies the private URL. This allows you to send the folder path to an e-Builder user.
If the recipient is not already logged into e-Builder, they'll be required to login in order to access the
file.

Public URL - Displayed if the folder is enabled for public access. Click to copy the URL to the clip-

board.

Email Address - Displayed if the folder is configured to accept email from external parties. Click to
copy the email address to the clipboard. For instructions on configuring the folder to accept email,
see Email Enable Folders.

Folder Properties - General

This window is displayed when the folder "properties" link is selected on the Project Documents page. The
General tab is highlighted by default.

From this page, you can take the following actions:

* Move folders

¢ Give Public Access to Folders

¢ Enable Folders for Public Access

¢ Email Enable Folders

Buttons

Fields

Save: Click to save changes.

Move: Click to move the folder to a different folder within the project's folder structure. Please note
that moving folders does not create a duplicate, rather the folder is completely removed from its ori-
ginal location.

Delete: Click to delete the folder. You are prompted for confirmation.

Cancel: Click to discard changes and close this page. All unsaved changes will be lost.

Name: Displays the name of the folder. This is also an editable field.
Description: Displays a description of the file, if one exists. This is also an editable field.

Document Type: Displays the document type selection for this folder. This can be defaulted by the
administrator on the Custom Fields tab.

Folder URL: Displays the folder's private web address. Recipients will need to login to e-Builder
Enterprise™ in order to view folder contents.

Location: Displays the folder path of the folder location.
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e Added By: Displays the user that created the folder.

» Date Added: Displays the date that the folder was added.

» Last Modified By: Displays the name of the person that made changes to the folder last.

« Date Modified: Displays the date that the folder was modified.

e Public Folder URL: Displays only if the folder is public. Otherwise, Folder is not public displays. If
enabled for public access, the public web address displays for you to provide external users folder
access. For instructions, see Enable Folders for Public Access.

e e-Builder Sync URL: Displays the e-Builder sync URL that can be used to create a shortcut to this
folder when transferring files using e-Builder Sync. e-Builder Sync allows you to transfer files
between your local computer or network server and the e-Builder document structure. This field is
displayed only if this feature is enabled for the account and project. Account administrators have the
ability to enable this feature. For instructions, see Set up e-Builder Sync Options.

» Public Access Permissions: Click to select a public access permission setting. For instructions,
see Give Public Access to Folders.

Choose from the following:

° No public access allowed: (default selection)

o Allow access without registration

° Regquire registration to access: Select this option to require the recipient of the folder URL
to create an e-Builder username and password in order to login to the system. You will then
be able to view a list of all registered users by clicking the Public Access History tab:
Registered Visitors tab, from this window. See Folder Properties Public Access History Tab
for an overview of this page.

° Show public sub-folders on public view: This check box is displayed when you choose to
allow public access. Select this check box to also enable access to sub-folders.

e Folder Access Options: Allow Email In: Select to allow both internal and external users to email
files to this folder. Three additional options display:

o Store entire email message: Select this check box to store both the email and its attach-
ments in this folder.

o Store attachments separately: Select this check box to store attachments in the same
folder, but as a separate item than the message.

° To send e-mails to this folder, use: A default email address will populate in this field that
may be edited, but it must be a unique name. This will be the email address for this folder.

Folder Properties - Custom Fields

This tab allows you to view and modify the folder's default document type and set default values for the custom
fields.

This tab does not display if the Project Document Control has not been enabled on the Project Details Settings
tab. The administrator must also establish document type and custom field associations.

From this tab, you also have the option to set custom fields to read only so that users cannot change the
default value. Applying default values will apply them to all files currently in the folder.
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If you would like to modify the custom fields for multiple files or folders at once, go to the Document Custom
Fields page, where you can scroll through all the files in a given folder and specify the custom fields for each.

Fields and Buttons
The fields and buttons on this page are:
» Save: Click to save changes.
e Cancel: Click to discard changes and close this page. All unsaved changes will be lost.

* Apply default values to all files within this folder?: Select to apply the defaulted custom field val-
ues to all files within this folder.

e Document Types: Click to select a default document type for the files in this folder. Associated cus-
tom fields display in the Custom Fields section below. For instructions on establishing document
type and custom field associations, see Associate Custom Fields with Document Types.

e Custom Fields: Displays the custom fields that are associated with the document type. Enter a
value for each custom field.

Related Topics:

¢ Add Document Types
¢ Add Document Custom Fields

Folder Properties - History
The history log of a folder allows account and project administrators to see who accessed the folder, when it
was accessed, and in what manner. Below is a description of the fields and buttons located on this page.

¢ Name: The name of the user who accessed the folder.

e Company: The company associated with the users who accessed the folder.

¢ Timestamp: The date and time that the folder was accessed.

¢ Access: The manner in which the folder was accessed.

Folder Properties - Permissions

This tab allows you to view and modify folder permission settings. When a document is uploaded, it inherits the
parent folder's permission settings. Even though settings for individual files can be changed, it is not recom-
mended. Folder permissions are role specific, and cannot be set for individual users. Add the roles you wish to
specify permissions for, and then create your settings for each selection. For instructions, see View/ Edit
Folder Permissions.

Note: If the role is not listed in the folder permissions, it means that the specific role does not have access to
this folder. For instructions on granting a role folder access, see Add Account Roles to Folders.

To access the Folder Properties Permissions tab
1. Go to the Project Documents Page.
2. On the Project menu, click on the Folder Permissions link.

The Folder Permissions page is displayed.

The fields and buttons located on this page are described below:
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Toolbar options
» Apply: Select one of the following options:
o Apply to folder: Select to apply folder permissions to only the current folder.

° Overwrite existing (folder & subfolders): Select to overwrite the current permission set-
tings and apply folder permissions to sub-folders and their files.

° Apply changes (folder & subfolders): Select to replace existing permissions in sub-folders
with this folder's permissions for only the changes that we just made. If only one role was
updated it will apply just that role to the files and sub-folders and will ignore every other role.

e Add: Click to open the Add Permissions window and select the account roles or users you want to
set access rights for. For your convenience, you have the choice of specifying permissions on the
Add Permissions window or on this page; the same permission check boxes are available on both.

* Remove: Click to remove the selected role from the list of roles below. This effectively removes
restricts this role from having access to this folder.

Folder Permissions

e Document Owner: This role is displayed by default and refers to the person who originally
uploaded the file. Users with Modify permission are able to change the permissions for this role, but
by default, the Document Owner inherits the following permissions:

° View

° Download

° Redline Markup

° Modify

° Version Control

° Delete

° Change Perms
Note: The Document Owner automatically inherits Version Control permission which will allow
them to delete all versions of a file. Take careful consideration of the document owner's role
before allowing them to maintain all of the default permission settings. For example, if an admin-

istrative assistant uploads an initial set of shop drawings, you may or may not want to give them
the permission to delete all subsequent versions of those drawings.

e Members List: Click a user group or role link to open the Members window and view the members
of the selected project role group.

e View: Select to allow users in the highlighted role permission to view this folder in this project and in
all projects that the file is available in. (Any author or recipient of the file will be able to see the files
they created/ received, regardless of this permission.)

Note: The permissions to the files can be changed on the file level by going to the File Properties
Permissions Tab. The author of the file will always have full access.

* Download: Select to allow users in the highlighted role to download the file to a local storage in the
native format that the file was uploaded in.

Page xxxiv



Trimble Unity Construct

e Redline Markup: Allows users to redline files and compare documents.
» Modify:Allows users in the highlighted role to update the folder, document name and description.

e Version Control: Allows users in the highlighted role to check files in and out. This will allow them to
create new versions of a file.

Note: For attached documents within processes, version control will always be enabled on the
specified default folder, regardless of the step actor's permission levels.

e Create: Allows users in the highlighted role to upload files to this folder.

» Create Folder: Allows users in the highlighted role permission to create sub-folders.

e Delete: Assigning the Delete permission to the Document Owner, a User or Group will allow them to
delete files that they created in that folder.

Assigning the Delete permission to an actual role will allow them to delete files (even those that they
did not create) and the folder itself.

e Change Perms: Allows users in the highlighted role to update permissions for this folder.

e Public Access: Allows users in the highlighted role to configure a folder's public access settings.
The users can make a folder public or private, require registration to access the folder or allow
access to it without registration.

* No Access : This role has no access to this file. This permission overrides any other permissions
the user may be granted.

Folder Properties -Subscribers

The Subscription tab allows you to manage folder subscriptions for yourself, and if you are an administrator,
for others as well. You are able to complete the following tasks from this page:

Subscribe yourself to Folders
Unsubscribe yourself or users from folders
Edit folder subscriptions for yourself
Subscribe users to folders

Edit folder subscriptions for users

Fields and Buttons

The fields and buttons located on this page are:

Subscribe: Click to create the folder subscription.

Note: If you subscribe yourself to a folder, you're able to unsubscribe at any time, but if the sub-
scription was created by an administrator, only the administrator can cancel your folder subscription.

Cancel: Click to cancel and close this window. All unsaved changes will be lost.
Action: Select the action that you want to take:
° Subscribe: Select to create a folder subscription.

° Unsubscribe: Select to unsubscribe the folder. This option is only available when you subscribe
yourself or you are an administrator.
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° Modify Subscription Type: Select to make changes to the details of this subscription. This
option is only available when you subscribe yourself or you are an administrator

¢ Subscribers
° Subscribe Myself: Select to add yourself to the folder subscription.

o Available Subscribers: Select the Roles, Groups, and/or individual users to add to the sub-
scription. This option is available to Administrators only.

¢ Subscription Type
° Daily Summary: Select to receive email that summarizes of activity of this folder daily.
o Instant Notification: Select to receive an email notification as soon as any activity is taken on
the folder.

¢ Include Subfolders: Select to include subfolders in the subscription.

Folder Properties -Recycle Bin

This tab is only visible to users with administrative permissions. The Recycle Bin tab lists all deleted files and
folders and makes it possible to restore them. For instructions, see Restore Deleted Documents.

Fields and Buttons
The fields and buttons located on this page are:
¢ Restore: Click to restore deleted items to their original location and status.
¢ Cancel: Click to close the window.
¢ Name: Displays the name of the deleted item.
¢ Date Created: Displays the date and time the item was created.
¢ Date Deleted: Displays the date and time the item was deleted.

¢ Deleted By: Displays the user's name that deleted the item.

Folder Properties - Public Access History

The Public Access History tab is only visible to users with administrative permissions. This tab allows you to
view the access history of public folders. From this tab you're be able to see the person's name, time of
access, and the contact information of all project participants that have ever accessed this folder. For instruc-
tions, see View Access History of Public Folders.

Fields and Buttons

The fields and buttons located on this page are:

Access History Tab
This tab allows you to see the number of times this folder has been accessed.
e Timestamp: Displays the date and time the folder was accessed.
e Company: Displays the company name associated with the person that accessed the folder.

« Name: Displays the name of the person that accessed the folder.
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¢ Email Address: Displays the person's email address.

¢ Cancel: Click to close this window.

Registered Visitors Tab
This tab displays the information of registered visitors.
» Company: Displays the company name associated with the person that accessed the folder.
¢ Name: Displays the name of the person that accessed the folder.
« Email Address: Displays the person's email address.

¢ Cancel: Click to close this window.

Import Folder Permissions Page

You are taken through a two step wizard when importing folder permissions.
A description of each step is below.

Note: For detailed steps see Import Folder Permissions.

Step 1
« Remove permissions not in import file: Select to remove existing permissions in e-Builder that
are not in the import file.

e Download Import Template (.xls): Click to download a template of the import file to help you get
started. The headers of your import file should include the following titles:

° Folder Path

° Group, Role, or User

° View

° Download

° Redline Markup

° Modify

° Create

° Create Folder

° Delete

° Change Perms

° No Access
e Browse: Click to select the import file.
» Next: Click to go to the next step of the import process after all fields have been completed.

e Cancel: Click to cancel the import and return to the Folder Permissions page.

Step 2 (Review)
» Preview Tab: This tab is displayed by default and allows you to review the details of the import;
whether it was successful or not. The number of rows imported appears on the tab name.

» Exceptions Tab: Lists details of all errors, if any. Click the Export Exceptions button to export
details to a spreadsheet.
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* Warnings Tab: Lists all warning messages, if any. The Warnings tab lists information additional per-
missions that might be inherited.

Working with Folders

You can perform the following actions on folders:

Create Folders

Note: You need to be an administrator or have Modify permissions to perform this task. For more inform-
ation, see Edit Folder Permissions.
To add folders to the Documents folder structure
1. Go to the Project Documents page.
Click the Create Folder link.
To make this a sub-folder, click the Change Folder link in the Parent Folder field.
On the Select a folder dialog box, select the parent folder for this new folder.
Complete all necessary fields.
Click Save.

On the Folder Properties window, optionally perform the following actions:

N o o e DN

° Enable Folder for Public Access

° Edit Folder Permissions

© Subscribe Yourself to the Folder

© Subscribe Users to the Folder (Administrators only)
8. Click Save.

Move Folders

All folders except the Documents folder can be moved.

To move folders
1. Go to the Project Documents page.
Click the folder that you wish to move.
Click the Properties link.
On the Folder Properties General Tab click Move.

Select a destination for the folder.

o gk w D

When prompted to confirm, click OK.

Enable Folders for Public Access

Administrators have the ability to provide public access to e-Builder folders. Once these settings are estab-
lished, a public folder URL becomes available for distribution.

To make a folder public
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1. Go to the Project Documents page.
2. Click the name of the folder you want to make public.
3. Click the Properties link underneath the folder path.

Documents

Upload Create Folder | Subscriptions | Copy To Clip

[ | MName «
Delete | Move | Copy | Download | Check Out | Send | Fill

e-Builder Individually Licensed User Guide.pdf (v
Download (6520.2KB) | Redline | Compare | Send Prop

BE

Values.xls (version1)
are | 5end Properties |

(=;

4. Click the Public Access Permissions drop-down arrow and select a public access option. The fol-
lowing options are available:
° No public access allowed (default selection)
° Allow access without registration
° Require registration to access - Select this option to require the recipient of the folder URL to cre-
ate an e-Builder username and password in order to login to the system. You will then be able to
view a list of all registered users by clicking the Folder Properties Public Access History Tab.
5. Optional: You can choose to enable sub-folders for public view as well by clicking the Show public
sub-folders on public view check box.
Click Save.
If you chose to include sub-folders, confirm this change by selecting the Apply this setting to all sub-
folders check box.
8. Click Save.

Note: After the folder is made public, a Public URL link displays in the section underneath the folder name.
Click this link to copy the public web address to your clipboard for distribution.

Documents

Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard: Private URL - Public URLl

[ | Name « Date Uploaded

Delete | Move | Copy | Download | Check Out | Send | Fill Out Form

User Guide.pdf (version 3)
E erties |

e-Bui

021213 03:02PM

Tip
To view the public web address, click the Properties link. The web address is listed in the Public Folder URL
field.

Related Topics:
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¢ Send Public Folder URL to External Users

¢ Folder Properties - General Tab Page Overview

Send Public Folder URL to External Users

In order for a folder to have a public URL available, it needs to first be enabled for public access. For instruc-
tions, see Enable Folders for Public Access.

To send a folder's URL to external project participants
1. Go to the Project Documents page.
2. Inthe Copy To Clipboard field, click the Public URL link.
The URL is copied to your clipboard.

3. Paste the URL (CTRL + V) in the appropriate location for sending.

Related Topics:

¢ Project Documents Page Overview

Email Enable Folders

Administrators and users with Change Permission have the ability to enable folders to receive email messages
from both internal and external project participants. Once this setting is configured, an email address is auto-
matically generated for the folder. You are able to view, and if necessary, edit this email address to a unique
name. Messages appear in the folder as a .msg extension.

Note: Microsoft Outlook® is required to download and open message files outside of Trimble Unity Con-
struct. Simply click the message title to open it within the system.

Floor Plans / Roof / Earth Science Wing
Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard:
[ Mame =

Delete | Mowe | Copy | Download | Check Qut | Send | Fill Qut Form |

& Roof Specifications for Earth Science Wiuersinn 1)

Download [21.8KE] | 5end | Properties

Tip
Set up a folder subscription so that you are notified when an email has been sent to this folder. You will also
be notified of all other updates to the folder.

To email enable folders

1. Go to the Project Documents page.
2. Click the folder's Properties link.
The Folder Properties - General Tab displays.
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3. Inthe Folder Access Options field, select the Allow Email In check box. Additional options are dis-
played.

4. Select the Store entire email message check box to store emails in Trimble Unity Construct, along
with their attachments.

Note: The attachment will still be accessible within the message. If opened in Outlook, it will be an
attachment. If opened in Trimble Unity Construct, it can be accessed from the Attachments tab

5. Select the Store attachments separately check box to save attachments as a separate file within the
folder.
| Note: This option stores the attachments only. The email message file is not retained.

6. The default email address is displayed in the To send e-mails to this folder, use: field. This field is
editable. Change the email address as necessary.

7. Click Save.

Folder Subscriptions

You can perform the following actions on folder subscriptions:

Subscribe Yourself to Folders

Subscribing yourself to a folder allows you to receive email notifications whenever the folder's contents
have been updated. If you are an account or project administrator, you can also subscribe account roles,
groups or individual users; for more information, see Subscribe Users to a Folder.

To subscribe yourself to a folder

Go to the Project Documents page.
Select the folder you want to subscribe to.

3. Click Subscriptions.

Folders I:I_Ii: ET Documents
Expand All | Collapse All | Refresh All || Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard:
E-{] Documents [2] [[]  Name =
E-{7] Bid Responses [0] )
fns By Delete | Move | Copy | Download | Check Out | Send | Fill Qut Form
"|:| Bidding [0] . i . . )
i . = e-Builder Individually Licensed User Guide.pdf [version 3)
W ot ] 2 I pownload (620.2K8) | Redline | Compare | Send Properties |
~{eb Plan Room [3] 4 Schedule of Val is ersion1)
e | & Schedule of Values.xls (version
i;‘ Procurment [0] = D Download (17 4KE) | Compare | Send Properties |
"|:| Pro

4. Select a subscription type.

° An instant notification will send you an email whenever a new file is uploaded to the folder,
a new version of a file is created, afile is deleted, or if a file is redlined.
° A daily summary will send you a recap of everything that has happened during the previous
day.
5. Toinclude subfolders to the subscription, select the Include Subfolders check box.
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6. Click Subscribe.

Unsubscribe Yourself From Folders

Note: If your folder subscription was created by an Administrator, only an Administrator can unsubscribe
you from the folder. You re able to unsubscribe yourself only if you created the subscription.

To unsubscribe yourself from a folder

1. Go to the Project Documents page.
2. Select the folder you want to unsubscribe from.
3. Click Subscriptions.

The Folder Properties popup window displays with the Subscriber tab selected.
==

Folders L & || Documents
Expand All | Collapse All | Refresh All || Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard:
E-{"] Documents [2] [[]  Name «

|:| Bid Responses [0]
#-{7] Bidding [0]

{7 Construction 11 et ]
{3 Plan Room [3] I
|:| Procurment [0]
|:| Pro

Delete | Move | Copy | Download | Check Out | Send | Fill Qut Form

e-Builder Individually Licensed User Guide.pdf jversion 3)
Download [620.2KE) | Redline | Compare | Send Properties |

Y

L @_l ] Schedule of Values.xls (version 1)
= Download (17 .4KB) | Compare | Send Properties |

4. Selectthe Unsubscribe radio button.
5. Tounsubscribe from subfolders as well, select the Include Subfolders check box.
6. Click Unsubscribe.

Edit Personal Folder Subscriptions

There are two types of folder subscriptions; instant and daily, and you have the choice to select one or both.
Instant subscriptions send an email notification just as soon as there is any activity in folder. Daily sub-
scriptions will send you a daily email. You can also modify the subscription to include or remove subfolders.

To edit folder subscriptions
Go to the Project Documents page.
Select the folder you want to modify subscriptions for.

Click Subscriptions.
The Folder Properties popup window displays with the Subscriber tab selected.
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] =

Folders Ce| / || Documents
Expand All | Collapse All | Refresh All || Upload | Properties | Create Folder | Subscriptions | Copy To Clipboard:
E-{] Documents [2] [  Name=

|:| Bid Responses [0]

dens i Delete | Move | Copy | Download | Check Out | Send | Fill OQut Form
E-{] Bidding [0]

.- - e-Builder Individually Licensed User Guide.pdf (version 3)
[ Construction [1] ip=ls Download (520.2KE) | Redline | Compare | Send Properties |
~{=} Plan Room [3] 4 S chedule of Val e

e n chedule of Values.xls (version

"ij Procurment [0] & [

Download (17 4KB) | Compare | Send Properties |

4. You can take any of the following actions:

° To change the subscription type, select the Daily Summary and/or Instant Notification
check box.

Note: An instant notification will send you an email whenever a new file is uploaded to the
folder, a new version of a file is created, a file is deleted, or if a file is redlined. A daily sum-
mary will send you a recap of everything that has happened during the previous day.

° Toinclude subfolders, select the Include Subfolders check box.
5. Click Subscribe.

Folder Permissions

You can perform the following actions on folder permissions:
View Folder Permissions

Note: You need to be an administrator or have Change Permission privileges to perform this task. For
more information, see Edit Folder Permissions.

To view folder permissions

Go to the Project Documents page.
2. Click Folder Permissions located in the Project Menu.

The Folder Permissions page displays.

3. Navigate to the folder you want to view permissions for.

Export Folder Permissions

Exporting the folder permissions gives you a digital copy that can be distributed, printed, or saved and then
modified to be imported back into e-Builder.

To export folder permissions

Go to the Project Documents page.

From the Project Menu, click Folder Permissions.
Click Export.

The Select Output Type menu displays.
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4. Select Print View for a printable version of the file, which cannot be imported back into e-Builder.
—Or—
Select Excel Data Export for a file version that can be modified and imported back into e-Builder.
5. Click Export.

Import Folder Permissions
Folder permissions can be imported to reduce the time it takes to make these changes manually. A tem-
plate file is available on the Import Folder Permissions page to help you get started. Likewise, you can
export the current folder permissions to make the necessary changes and then import this file to update
these settings in e-Builder.

Note: The import supports only .xls or .xlsx files.

Below is an example of the headers that should be included in your import file.

A B G H | J K

C D F
Folder Path Group, Role, or User View Download Redline Markup Modify Create Create Folder Delete Change Perms No Access
5 ¥

Fall Lakes | Accounting

m

£l Fall Lakes\ Approver

L Fall Lakes \ 01 Internal Only % e-Builder Admin

M Fall Lakes\ 01 Internal Only \ Members

i8I Fall Lakes \ 01 Internal Only \ Project Manager

{8 Fall Lakes \ 01 Internal Only Senior Bid Manager
N Fall Lakes 1 01 Internal Only \ 00 Miscellant Accounting

1
ERFall Lakes \ Architect
(]

545 b be 3 3 )
>
=
>
>
=

3 X3
3¢ 33 > 3¢ >

To import folder permissions

1. Go to the Project Documents page.
From the Project Menu, click Folder Permissions.
Click Import.

The Import Folder Permissions page is displayed.

w

Click Browse.

Search for and select the import file.
Click Next.

Review the import file summary.

If available, review any warnings by clicking the Warnings tab.

© © N o g -

If there are no exceptions, click Import.
—Or—
If there are exceptions, click the Exceptions tab to review what they are. Many the necessary
changes to the import file, and then click Previous to import the updated file.
Add Account Roles to Folders
To specify unique permissions for account roles, they must first be added to the folder. The Project Admin-

istrator and Project Member groups are added to each folder by default.

Note: You need to be an administrator or have Change Permission privileges to perform this task. For
more information, see Edit Folder Permissions.

To add account roles to a folder
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1. Go to the Project Documents page.

2. Click the Folder Properties link.

3. Click the Permissions tab.

4. Click the Add link.

5. Inthe Account Roles section, select the check box next to the account roles you want to add.

6. Inthe Select Which Permissions To Grant section, select the type of access to grant the selected
users.
For a description of these access types, see Folder Properties Permissions Tab Overview.

7. Click Add.

Tip
Ensure that all users in the selected account role(s) are those that need the permission level that
you have granted. To do so, from the Folder Properties - Permissions tab, select the account
role, and then click the List Members link. A pop-up window displays with a list of the member in
the selected account role.

Add Individual Users to Folders
To specify unique permissions for individual users, they must first be added to the folder. The Project

Administrator and Project Member groups are added to each folder by default.

Note: You need to be an administrator or have Change Permission privileges to perform this task. For
more information, see Edit Folder Permissions.

To add folder permissions for individual users

Go to the Project Documents page.

Click the Folder Properties link.

Click the Permissions tab.

Click the Add link.

Select the Show Users check box.

o N~

A filter displays, which allows you to filter for the users you want to add. A list of project users also
display, which you can access by scrolling beneath the fold.

In the Project Users section, select the check box next to the user(s) you want to add.

7. To set permissions for the user at this time, select the appropriate access type(s) in Select Which
Permissions To Grant section. For a description of these access types, see Folder Properties Per-
missions Tab Overview.

8. Click Add.
Edit Folder Permissions
Note: You need to be an administrator or have Change Permission privileges to perform this task.

Folder permissions can only be modified for existing groups and individual users that have been added to
the folder.

To edit folder permissions

Page xlv



Trimble Unity Construct

1. Go to the Project Documents page.
2. Click Folder Permissions located in the Project Menu.
The Folder Permissions page is displayed.
3. Click the Edit link next to the folder you want to edit permissions for.
The permission check boxes are enabled.
4. Select the check boxes of the permissions you want to assign and clear the check boxes of the per-
missions you want to remove.
5. Click the Save link.
Tip
Click the folder name to view a description of each permission type. The Folder Properties - Per-

missions tab displays. You are also able to modify the permissions from this tab. For additional
explanation on the permissions levels, see Folder Properties Permissions Tab Overview.

Administrative Tasks

Certain folder management tasks are available only to users with Admin permission.

Folder Permissions Page

Note: You can only update permissions for roles that already have folder access. You cannot add a new
user role from this page.

The Folder Permissions page allows you to view and modify permission settings for each folder in the Docu-
ments folder structure. Additionally, the entire folder structure can be exported, and then reimported into e-
Builder in order to update project folders permissions. From this page, permissions are set for administrators,
members, roles or individual users.

To access the Folder Permissions page

Note: Administrators: To grant users the ability to perform this task, give them Change Permissions priv-
ileges. For instructions, see Edit Folder Permissions.

1. Go to the Project Documents page.

2. Click Folder Permissions located in the Project Menu.

Below is a description of the fields and buttons located on this page.
¢ Folder Permissions For: Click to view folder permissions for a different project.
¢ Import: Imports folder permissions. From here you're able to download a template file.

e Export: Exports the current folder structure and permissions. You're able to select from two output
types: Print View and Excel Data Export. The print view is more aesthetic and is used for distribution.
The Excel Data output can be modified and then imported back into e-Builder.
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¢ Also apply to files: Select to apply the folder permissions to the individual files as well.

Warning: The Apply action is the only way to save changes to folder permissions. If you nav-
igate to another folder without applying changes, a warning message will be displayed.
However, if you navigate away from this page, your changes will be lost.
After setting the desired folder permissions, click this drop-down arrow to select how to apply the
permissions. Choose from the following options:

o Apply to folder - Applies changes to the selected folder only.

o Overwrite existing (folder & subfolders) - Overwrites subfolder permissions to match the
selected folder's permissions. This option will remove any conflicts between the selected folder
and its subfolders to match the selected folder exactly.

° Apply changes (folder & subfolders) - Select to apply changes only. This option will not over-
write existing permissions - it will only apply changes that you've made to the folder and/or sub-
folders.

Add: Adds account roles and project groups to the list of roles that has been given permission.
¢ Remove: Removes the selected roles or groups from the list.

¢ Group, Role, or User: This column lists the groups and roles that can be given folder access.
¢ View: Allows users to view the folder and the files within the folder.

¢ Download: Allows users to download files.

Redline Markup: Allows users to redline files and compare documents.

Modify: Allows users to edit the folder name and description. This permission also allows users to
move files from the folder.

Create: Allows users to upload files.
* Create Folder: Allows users to create sub-folders within the current folder.

Delete: Allows users in the role or user group to delete files and folders, regardless of who created it.
Users without delete permission can only delete the files that they uploaded.

Allows Document Owners to delete their own files in that folder. They cannot delete other files or the
folder itself.

¢ Change Perms: Allows users in the selected role to change folder permissions.

¢ No Access: Select to override all other permissions. If someone is in two roles and one of the roles has
this permission, selecting this check box will override all other role permissions for the user.

Add Account Roles to Folders

To specify unique permissions for account roles, they must first be added to the folder. The Project Admin-
istrator and Project Member groups are added to each folder by default.

Note: Administrators: To grant users the ability to perform this task, give them Change Permissions priv-
ileges. For instructions, see Edit Folder Permissions.

To add account roles to a folder
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1. Go to the Project Documents page.

For instructions, see Access Project Documents Page.

2. Click the Folder Properties link.
The Folder Properties General Tab displays.

3. Click the Permissions tab.

The folder's permission settings displays.

4. Click the Add link.

The Add Permissions window displays.

5. Inthe Account Roles section, select the check box next to the account roles you want to add.
In the Select Which Permissions To Grant section, select the type of access to grant the selected users.
For a description of these access types, see Folder Properties Permissions Tab Overview.
7. Click Add.
Tip
Ensure that all users in the selected account role(s) are those that need the permission level that
you have granted. To do so, from the Folder Properties - Permissions tab, select the account role,
and then click the List Members link. A pop-up window displays with a list of the member in the
selected account role.
Related Topics:

¢ Add Individual Users to Folders
* Edit Folder Permissions

Add Individual Users to Folders
To specify unique permissions for individual users, they must first be added to the folder. The Project Admin-

istrator and Project Member groups are added to each folder by default.

Note: Administrators: To grant users the ability to perform this task, give them Change Permissions priv-
ileges. For instructions, see Edit Folder Permissions.
To add folder permissions for individual users

1. Go to the Project Documents page.

For instructions, see Access Project Documents Page.

2. Click the Folder Properties link.
The Folder Properties General Tab displays.

3. Click the Permissions tab.

The folder's permission settings displays.

4. Click the Add link.
The Add Permissions window displays.

5. Select the Show Users check box.
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A filter displays, which allows you to filter for the users you want to add. A list of project users also dis-
play, which you can access by scrolling beneath the fold.

In the Project Users section, select the check box next to the user(s) you want to add.

7. To set permissions for the user at this time, select the appropriate access type(s) in Select Which Per-
missions To Grant section.

For a description of these access types, see Folder Properties Permissions Tab Overview.
8. Click Add.

Related Topics:
¢ Add Account Roles to Folders

+ Edit Folder Permissions

Edit Folder Permissions

Folder permissions can only be modified for existing groups and individual users that have been added to the
folder. For instructions on adding users to the folder, see the Related Topics section below.
To edit folder permissions
Go to the Project Documents Page.
2. On the Project menu, click on the Folder Permissions link.

The Folder Permissions page is displayed.

3. Click the name of the folder you want to edit permissions for. The permission check boxes are dis-
played on the right side.

4. Select the check boxes for the permissions you want to assign and clear the check boxes of the per-
missions you want to remove.

5. Click the Apply button.

Tip
Click the folder name to view a description of each permission type. For additional information on the per-
missions levels, see Folder Properties Permissions Tab Overview.

Related Topics:

¢ Add Account Roles to Folders
¢ Add Individual Users to Folders

Subscribe Users to Folders

Subscribing to a folder enables users to receive email notifications whenever the folder's contents have been
updated. Account and project administrator have the ability to subscribe account roles, groups and individual
users.

To subscribe users to a folder
1. Go to the Project Documents page.

For instructions, see Access Project Documents Page.
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2. Select the folder you want to subscribe the user to.
3. Click Subscriptions.
The Folder Properties popup window displays with the Subscriber tab selected.
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1_—7 Procurment [0] = 0 Download [17.4KB) | Compare | Send Properties |
"1:| Pro

4. Selectthe account roles, groups or individual users you'd like to subscribe, and then click the right
arrow to add them to the Selected Subscribers box.

5. Select a subscription type.

° An instant notification will send you an email whenever a new file is uploaded to the folder, a
new version of a file is created, a file is deleted, or if a file is redlined.

° A daily summary will send you a recap of everything that has happened during the previous
day.
6. Selectthe Include Subfolders check box to add subfolders to the subscription.
7. Click Subscribe.

Related Topics:
¢ Unsubscribe Users From Folders

¢ Edit Folder Subscriptions for Users

Unsubscribe Users From Folders
Note: If you create folder subscriptions for your team members, only yourself and other administrators will
have the ability to unsubscribe those users; team members will not be able to unsubscribe themselves.
To unsubscribe team members from a folder
1. Go to the Project Documents page.
For more information, see Access Project Documents Page.
Select the folder you want to unsubscribe users from.
Click Subscriptions.
The Folder Properties popup window displays with the Subscriber tab selected.
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Select the Unsubscribe radio button.

5. Inthe Subscribers section, select the check box next to the account roles, groups or individual users
you d like to unsubscribe.

To unsubscribe from subfolders as well, select the Include Subfolders check box.

Click Unsubscribe.

Related Topics:
¢ Unsubscribe Users From a Folder

e Edit Folder Subscriptions for Users

Edit Folder Subscription for Users

There are two types of folder subscriptions; instant and daily, and you have the choice to select one or both.
Instant subscriptions send an email notification just as soon as there is any activity in folder. Daily sub-
scriptions will send you a daily email. Additional modifications can be made by adding/ removing yourself from
the subscription, modifying the subscribers list or including/ removing subfolders.

To edit folder subscription for team members
1. Go to the Project Documents page.
For more information, see Access Project Documents Page.
Select the folder you want to modify the subscription for.
Click Subscriptions.
The Folder Properties Subscriber window is displayed.
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"] Construction [1] | O pownload (520.2kB) | Redline | Compare | Send Properties |
{5 Plan Room [3] 4 ! :
] I IZIJ H Schedule of Values.xls [version 1)
:‘ Procurment [0] — Download [17.4KB) | Compare | Send Properties |
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4. You can take any of the following actions:
° To subscribe yourself, select the Subscribe Myself check box.

° To add or remove groups, roles or individuals, click the appropriate directional arrow to move
users to the appropriate box.

° Toinclude subfolders, select the Include Subfolders check box.

° To change the subscription type, select the Daily Summary and/or Instant Notification check
box.

Note: An instant notification will send users an email whenever a new file is uploaded to the folder, a
new version of a file is created, a file is deleted, or if a file is redlined. A daily summary will send a
recap of everything that has happened during the previous day.

5. Click Subscribe.

Restore Deleted Documents & Folders

When users delete folders or documents, they are not permanently removed from the system and can be
restored by anyone with administrative permissions.

To restore deleted files and folders

1. Go to the Project Documents page.
Forinstructions, see Access Project Documents Page.

2. Click the Properties link underneath the folder path.

Documents

Upload Create Folder | Subscriptions | Copy To Clip

[ | Name =

Delete | Move | Copy | Download | Check OQut | Send | Fill

e-Builder Individually Licensed User Guide.pdf (v
Download [620.2KE) | Redline | Compare | 5end Prop

HE

Valuesxdls [version 1)
are | 5end Properties |

[=;

The Folder Properties window displays.
3. Click the Recycle Bin tab.
Select the check boxes of the files and folders you want to restore.
5. Click Restore.
Related Topics:
¢ Find Deleted Documents

¢ Folder Properties Recycle Bin Tab Overview

View Access History of Public Folders

Only users with administrative privileges are able to view the access history of public folders.
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To view the access history of public enabled folders

1.

Go to the Project Documents page.
For instructions, see Access Project Documents Page.

2. Click the Properties link underneath the folder path.

Documents

Upload Create Folder | Subscriptions | Copy To Clip

[ | Name =

Delete | Move | Copy | Download | Check OQut | Send | Fill

e-Builder Individually Licensed User Guide.pdf (v
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The Folder Properties window displays.

3. Click the Public Access History Tab.

View Document Access History
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Only administrators are able to view a document access history. A document's access history tells you exactly
who accessed files including the date and time they were opened.

To view a document's access history

1.

Go to the Project Documents page.
For instructions, see Access Project Documents Page.
In the Project Menu, click Access History.
The Access Document History page displays.
Filter for file(s).
Tip
To view all files, do not add any filter criteria and click Filter.

Optional: You can also export the document access history log to an Excel™ spreadsheet by clicking

the Excel icon.

Related Topics:

¢ Access Document History Page Overview

View/Export Document Log

Only administrators are able to view and export the document log. The following is a list of data included in the
document log:
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¢ Folder path

¢ File name

¢ File size

¢ User that uploaded the file

¢ Redline Counter and link to redlined file

¢ User that currently has the file checked out
¢ Date file was checked out

¢ Link to a list of items the file is attached to

To view or export the document log

1. Go to the Project Documents page.

For instructions, see Access Project Documents Page.

2. Inthe Project Menu, click Document Log.
The Document Log page displays.

3. Toexport these records, click Export.

The Select Output Type submenu displays.

4. Choose from one of the following options:
° Excel Data Export
© CSV Data Export
© Tab Delimited Text

5. Click Export.

Related Topics:

¢ Document Log Page Overview

Find Deleted Documents

Only users with administrative permissions are able to search for deleted documents.

To find deleted files
1. Go to the Project Documents page.
For instructions, see Access Project Documents Page.
2. Inthe Project Menu, click Find Deleted Documents.

The Find Deleted Documents window displays.
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3. Inthe Search for field, enter the name of the file, include the file extension, that you want to search for.

Narrow your search by selecting one or more of the Search in options.
Click Search.

Related Topics:
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¢ Delete Documents
¢ Restore Deleted Documents and Folders

¢ Find Deleted Items Page Overview

Update Folder Custom Fields

Only users with administrative permissions can perform this task. Updating folder custom fields enable folder
contents to automatically inherit the custom field values of the parent folder.

Note: In order to tag documents with custom fields, the administrator must enable account level document
control and establish document custom fields per document type. The individual project must also hae pro-
ject level document control enabled.

When all of these settings are in place, users will be automatically prompted to complete the document cus-
tom fields every time they upload a file to the Documents module. Tagging documents cannot be required,
and users can bypass the custom field assignment.

To update folder custom fields
1. Go to the Project Documents page.
For instructions, see Access Project Documents Page.
2. Click the folder Properties link.
The Folder Properties General Tab displays.
3. Click the Custom Fields tab. This tab does not display if Project Document Control is not enabled.

Select a Document Type from the drop-down list. The custom fields that have been defined for this
document type will display.

5. Click the custom field drop-down arrow for the values that you want to apply to the new documents
uploaded to this folder.

Check Read Only? if users should not be able to change the value.
Check Apply default values to all files within this folder to modify existing files in the folder.
Click Save.

Related Topics:

¢ About Document Custom Fields
¢ Update Document Custom Fields
¢ Review Folder and Document Custom Fields

¢ Enable Project Document Control

Review Folder and Document Custom Fields

You can view folder and document custom fields by accessing the properties of each individual folder or file.
However, to view custom fields for multiple files or folders, it is best to do so from the Document Custom Fields
page for a more efficient process.
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Note: All users are able to view this page, but only users with administrative privileges are able to view and
update folder custom fields. The Custom Fields menu option does not display if the Project Document Con-
trol has not been enabled.
To view folder and document custom fields
1. Go to the Project Documents page.
For instructions, see Access Project Documents Page.

2. Inthe Project Menu, click Custom Fields.

The Document Custom Fields page displays.
3. Select the folder or file you want to view custom fields for.

The custom fields display in the content pane.

Note: If you do not see expected files or folders, deselect the Show untagged files only option at
the top of the folders pane.

4. Optionally, you can make changes to custom field values, and then click Save to commit changes.

Related Topics:

¢ About Document Custom Fields
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